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The Pennington Manual of Style 
from Teaching Essay Strategies 
 
 
COPYRIGHT © 2011, 2016  Pennington Publishing 
  
NOTICE TO THE READER 
 
 All rights reserved Pennington Publishing 2011. Permission is hereby 
granted to the individual purchaser to reproduce student materials in this book for 
noncommercial individual or classroom use only. Purchase of The Pennington Manual 
of Style grants you, the purchaser, and your students full license to use these resources 
at school and at home.  
  
Material from this book has been previously published in the author’s Teaching Essay 
Strategies © 2001, 2011, Grammar, Usage, Spelling, and Mechanics © 2013, Teaching 
Grammar and Mechanics © 2003, 2011, and Teaching Reading Strategies © 2008. 
These curricula are available for purchase at www.penningtonpublishing.com. 
  
Other than the heretofore specified limited permission for reproduction, the text of this 
publication, or any part thereof, may not be reproduced or transmitted in any form or by 
any means, electronics or mechanical, including photocopying, recording, storage in an 
information retrieval system, or otherwise, without prior written permission of the 
publisher. 
  
The Publisher makes no representation or warranties of any kind, including but not 
limited to, the warranties of fitness for particular purpose or merchantability, nor are 
any such representations implied with respect to the material set forth herein, and the 
publisher takes no responsibility with respect to such material. The publisher shall not 
be liable for any special, consequential, or exemplary damages resulting, in whole or 
part, for the readers’ or students’ reliance upon, this material. 
 
Curricula Designed to Teach the Essay e-Comments Content 
 
The Essay e-Comments have been derived from the following comprehensive curricula: 
Teaching Essay Strategies, Grammar, Usage, Spelling, and Mechanics, 
Teaching Grammar and Mechanics, and Teaching Reading Strategies and 
are available at www.penningtonpublishing.com. Each curriculum uses the same 
language of instruction as does The Pennington Manual of Style. Each curriculum 
provides diagnostic assessments to determine the individual needs of students in 
writing, spelling, grammar, mechanics, and reading. Each curriculum provides targeted 
worksheets with formative assessments and activities to enable the teacher to 
differentiate instruction.  
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Introduction 
 
The Pennington Manual of Style has been designed to serve both students and teachers.  
  
The user-friendly The Pennington Manual of Style provides 438 writing tips. Each 
writing tip has a concise definition, explanation, and a clear example. Writing tips are 
organized into these categories: Essay Organization and Development (Introduction, 
Body, and Conclusion), Coherence, Word Choice, Sentence Variety, Writing Style, 
Format and Citations, Parts of Speech, Grammatical Forms, Usage, Sentence Structure, 
Types of Sentences, Mechanics, and Conventional Spelling Rules. As a quick reference 
guide, this style manual will help developing writers learn what is correct and why it is 
correct.  
  
For teachers, this guide will provide a common language of writing instruction and 
discourse for teachers and students. Teachers will find the concise writing tips useful for 
both direct instruction and essay comments. And most importantly, all 438 writing tips 
have been formatted as Essay e-Comments for the Autocorrect function of Microsoft 
Word®. After adding in the comment bank, the teacher simply types in the assigned 
alphanumeric code and the entire formatted writing comment appears where desired on 
the student’s Word document or on a printed comments page. Batch load into Google 
Docs if you wish. 
 
The Pennington Manual of Style (included in Teaching Essay Strategies) includes the 
download all 438 Essay e-Comments. The following instructions show you how to 
manually insert the Fallacious Reasoning essay e-comments into Microsoft Word®.  
The comments work fine with Google docs. Simply batch download into Word®, open 
the docs in Word® and insert the comments. Upload back to Google docs, if you wish, 
and maintain the comments. 
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How to Add the Fallacious Reasoning e-Comments and Your 
Own Permanent Autocorrect Entries into Microsoft Word® 
 
1. You can add my e-comments and your own into permanent storage on Microsoft 
Word®. Here’s how: Copy and paste or type the e-comment. The text can include up to 
255 characters of hyperlinks, different fonts, colors, italics, boldface, etc. Highlight, but 
don’t copy the e-comment. 
 
2. Click the Microsoft Word® File. Then click Options. Next click Proofing. 

 

 
 
3. Now click AutoCorrect Options. This page is similar in all recent Microsoft Word® 
versions. The highlighted text will appear within the With: text box.  
 
4. Enter an alpha-numerical code in the Replace: text box and click OK. You’re done! 

 

 

Here is where the highlighted text appears. 
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Essay Introduction e-Comments 
 
Introduction Paragraphs 
 
e1 Needs Another Introduction Strategy Use at least two introduction strategies. 
Add a Definition, Question to be Answered, Reference to Something Known in 
Common, Quote from an Authority, Preview of Topic Sentences, Startling Statement, 
Background, or Controversial Statement. DQ RAPS BC 
  
e2 Needs a Different Introduction Strategy Use a variety of introduction 
strategies. Add a Definition, Question to be Answered, Reference to Something Known 
in Common, Quote from an Authority, Preview of Topic Sentences, Startling Statement, 
Background, or Controversial Statement. DQ RAPS BC 
  
e3 Introducing Evidence Don’t introduce evidence in an introduction. You may 
preview your topic sentences, but don’t include Fact, Example, Statistic, Comparison, 
Quote from an Authority, Logic, Experience, or Counter-Argument/Refutation. Save 
evidence for the body paragraphs. FE SCALE CR 
 
e4 Introduction Uses Narrative Genre An essay introduction doesn’t use a hook or 
lead, as does a narrative introduction. An essay introduction builds reader interest and 
understanding of the thesis statement, but keeps a formal essay tone. So, avoid “It was a 
dark and stormy night.”  
 
e5 Thesis Statement In an essay that requires the writer to inform the reader, the 
thesis statement should state your specific purpose for writing. The thesis statement 
serves as the controlling idea throughout the essay.  
 
e6 Thesis Statement In an essay that requires the writer to convince the reader, the 
thesis statement should state your point of view. The thesis statement serves as the       
argument or claim to be proved throughout the essay. 
  
e7 Thesis Statement does not respond to writing prompt. Re-read the writing 
prompt and dissect according to the WHO (the audience and role of the writer), the 
WHAT (the context of the writing topic), the HOW (the resource text title and author), 
and the DO (the key writing direction word). 
  
e8 Thesis Statement does not state the purpose of the essay. Dissect the writing 
prompt, focusing on the WHAT (the context of the writing topic), the HOW (the   
resource text title and author), and the DO (the key writing direction word) to 
specifically state the purpose of your essay. 
  
e9 Thesis Statement does not state the point of view of the essay. Dissect the 
writing prompt, focusing on to the WHO (the audience and role of the writer), the HOW 
(the resource text title and author), and the DO (the key writing direction word) to 
clearly state your specific point of view. 
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e10 Thesis Statement is too general. Get more specific in your thesis statement. 
Example: There were lots of causes to the Civil War. Revision: Although many issues 
contributed to problems between the North and the South, the main cause of the Civil 
War was slavery. 
  
e11 Thesis Statement is too specific. Your thesis statement needs to be a bit broader 
to be able to respond to the demands of the writing prompt. A good thesis statement is 
like an umbrella-it must cover the whole subject to be effective. Save the specificity for 
the body paragraphs. 
 
e12 Thesis Statement is inconsequential. The thesis statement must state a 
purpose or point of view that can be meaningfully developed in the essay.  
Example: People in France really enjoy their cheese. Revision: The French especially 
enjoy four types of cheeses. 
  
e13 Thesis Statement cannot be argued. An essay designed to convince a reader of 
the author’s specific point of view must provide a thesis statement that is arguable.      
Example: Blue is the best color. Revision: Blue is the best color to complement a bright 
white background. 
e14 Split Thesis Statement Don’t write a split (divided) thesis. A split thesis includes 
two purposes or two points of view. Focus on only one purpose of point of view       
throughout the essay. It may be necessary to reference or refute another purpose or 
point of view in the body paragraphs or conclusion.  
 
e15 Thesis Statement responds to only part of the writing prompt. Dissect the 
writing prompt according to the WHO (the audience and role of the writer), the WHAT 
(the context of the writing topic), the HOW (the resource text title and author), and the 
DO (the key writing direction word) and include each part. 
 
e16 References to Own Writing Don’t include references to your own writing in the 
thesis statement. Examples: In this essay… The following paragraphs… I will prove 
that… The evidence will suggest that… The purpose of this essay… My point of view is 
that… In my opinion… 
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How to Insert Essay e-Comments into Microsoft Word® and 
Google Docs (Grading and Responding to Student Essays) 

 
The Pennington Manual of Style (included in Teaching Essay Strategies) includes the 
download all 438 Essay e-Comments. The following instructions show you how to 
manually insert the Fallacious Reasoning essay e-comments into Microsoft Word®.  
The comments work fine with Google docs. Simply batch download into Word®, open 
the docs in Word® and insert the comments. Upload back to Google docs, if you wish, 
and maintain the comments. 

 
2. Open up a student’s essay in Microsoft Word®. Use the Quick Reference Guide with 
the alphanumeric entry codes and a short comment description, to guide your essay e-
comment selection. The Quick Reference Guide organizes the essay e-comments into 
writing response categories. Highlight the ones you use most often. 
 
3. Go to the Review tab in the Comments group. Left click the mouse where you want 
to place a comment. Click the New Comment image. In older Microsoft Word® 
versions, go to the Insert tab and then to Comments. 

 

 
 
4. The comment balloon will appear in the right margin or in a reviewing pane at the 
bottom of the screen or to the left of the screen. Adjust the comment location under 
Reviewing Pane in the Track Changes group. The keyboard shortcut to include a 
new comment is Ctrl + Alt + M. 
 
5. Type in the alphanumeric code for the selected essay e-comment and full comment 
appears in the comment balloon or where you decide is best. 

 

 
 
6. For repeated errors, simply highlight the text. The yellow marker is found under the 
“Home” tab. Of course, not every error need be marked. Consider using a balance of 
content and process essay e-comments, depending upon the instructional focus and the 
needs of each writer. 
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7. You can also personalize comments by adding to the comment balloons. You can even 
add audio comments to summarize overall strengths and weaknesses. To add an audio 
file (Sound Recorder) into Microsoft Word®, open Start; open All Programs; open 
Accessories; then open Sound Recorder. Click the button to start and stop 
recording. The Save menu will pop open and you can create a folder to save all of your 
audio files. Once saved, open up the folder and right click to copy the WMA file. Place 
your cursor where you want the file to appear in the student’s essay and paste Ctrl + V. 
The Sound Recorder file stays minimized as you open up other Microsoft Word® files, 
so you don’t have to go through the process each time. For better sound quality, I 
suggest using a microphone. 

 
8. Teach your students to revise and edit their documents in response to your essay e-
comments. I suggest using Microsoft Word® Track Changes. Teach your students to 
go the Review tab and click on Track Changes, then revise and edit their document 
by inserting, deleting, moving, or formatting text. The resources in Change Tracking 
Options provide custom color and formatting options. The keyboard shortcut to turn 
on Track Changes is Ctrl + Shift + E. 
 


